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Page 3: Table Of Contents
Start-up DKAdmin in MS-DOS ... 12 Run DKAdmin... 12 Set Windows DKAdmin Program
Properties... 13 Step 6: Connect to the Strata DK Telephone System ... 15 Chapter 3 – Installing
DKBackup Step 1: Check System Requirements ... 17 Step 2: Power Up DKBackup PC ... 18 Step
3: (Optional) Make Installation Floppy Disks ...

Page 4 Start-up DKBackup in MS-DOS ... 22 Run DKBackup... 22 Set Windows DKBackup
Program Properties... 23 Step 6: Connect to the Strata DK Telephone System ... 25 Chapter 4 –
Using DKAdmin/DKBackup Before You Start ... 27 Logging On ... 27 DKAdmin ...

Page 5 Speed Dial Programming Section ... 68 System Speed Dial Numbers ... 68 Station
Speed Dial Numbers... 69 ACD Administration ... 70 ACD Programs ... 70 ACD Agent Programs...
72 Program Administration Section... 73 View All Programs (Download, Edit, Upload) ... 74
Security Maintenance Section...

Page 6 Direct Connection to Strata DK ... 130 Connection to Strata DK Via Toshiba Data
Interface Units... 131 Customer Dialer Setup... 131 To Make Connection ... 131 Remote Modem
Connection to External Modem/TTY Port ... 132 Communication Setup ... 132 Customer Dialer
Setup... 132 To Make Connection ...

Page 7: Introduction
Chapter 8 – Options Menu explains how to change basic system parameters, maintain your
communication setup, view and print data, reindex files, and view system files. Appendix A –
Connecting to Strata DK shows how to connect a DKAdmin/DKBackup PC to the Strata DK
telephone system.

Page 8: Conventions
Primary Directory Number button (the extension Number for your telephone). [SDN] Secondary
appearance of a [PDN]. A [PDN] which appears on another telephone is considered an [SDN].
[PhDN] Phantom Directory Number button (an additional Directory Number). Screen Variations
The DKAdmin/DKBackup screens may vary from those shown in this document as selection
items are periodically modified.

Page 9: Related Documentation
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– Related
Documentation The following documents can be used to reference more information about the
Strata DK systems. Strata DK Programming Manual provides all instructions necessary to
program the system and system record sheets. Strata DK Installation & Maintenance Manual
provides installation instructions for configuring and installing the Strata DK14, DK16e, DK40
and DK424.

Page 10 How To Use This Manual
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– DKAdmin/DKBackup...

Page 11: Chapter 1 - The Grand Tour
DKAdmin/DKBackup programs do not support Strata DK8, DK16, or any DK24/56/96 releases.
The Toshiba Strata DK systems are powerful, state-of-the-art modular digital key/hybrid/PBX
telephone systems offering customers outstanding performance and flexibility. The advanced
technology behind the Strata DK enables customers to configure a system based on their
current telecommunications requirements.

Page 12: Basic Operations
Directory number call forward status (Release 3 or above) Directory number message waiting
status (Release 3 or above) ANI/Caller ID lost call telephone numbers (Release 3 or above)
Display existing station and port data in ASCII format. Control certain system menu access
through menu-specific user passwords.

Page 13 –––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– The
table below lists the options for each menu. A check mark ( ) appears next to the functions
which are available on that menu: Table 1 Main Menu Options Select Customer Select a
customer for whom you wish to program or update Strata DK system data.
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Page 14: Screen Conventions
Screen Conventions ––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
Main Menu Options (continued) Table 1 Distributed Hunt Group Administration Maintain
Distributed Hunt Group assignments. E911/CAMA Trunk Programs (R4 Only) Maintain
E911/CAMA trunk assignments. ISDN Programs (R4 Only) Maintain ISDN program assignments.
Call Forward Assignments Maintain call forward assignments. Backup/Restore Data Backup,
restore and/or upgrade Strata DK customer databases.

Page 15 –––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– Find
feature: Many of the screens in the DKAdmin/DKBackup programs have a Find feature for
customer IDs, program numbers, or port numbers. To use the feature, highlight the number
field you are searching (e.g., program number) and type the desired number. The
DKAdmin/DKBackup programs move the highlighter to the field requested.

Page 16 Screen Conventions
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
DKAdmin/DKBackup...

Page 17: Chapter 2 - Installing Dkadmin
Installing DKAdmin Step 1: Check System Requirements For optimum performance, run
DKAdmin on a personal computer with the following minimum specifications: IBM-compatible
Pentium® personal computer 100MB or larger hard drive CD-ROM or 3.5" 1.44KB high-density
floppy drive DKAdmin software is distributed on a CD-ROM disk. Installation can be performed
Note using the CD-ROM disk or from floppy disk(s) copied from the CD-ROM DKAdmin install
program.

Page 18: Step 2: Power Up Dkadmin Pc
Step 2: Power Up DKAdmin PC
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– From C:\280ADMIN\Data,
type del *.ntx and press Enter. From C:\280ADMIN\XXX.DK, type del *.ntx and press Enter. Run
ReIndex Files under Options/System Utilities Menu each time before you start to use DKAdmin.
Always exit DKAdmin before you turn your computer off. Step 2: Power Up DKAdmin PC Note
The DKAdmin Hardware Key must be installed on the PC LPT1 port, to enable the...

Page 19: Step 3: (Optional) Make Installation Floppy Disks
––––––––––––––––––––––––––––––––––––––––––––––––––––– Step 3: (Optional) Make Installation Floppy
Disks From Windows If you wish to install DKAdmin on a PC that does not have a CD-ROM, you
will need to make installation floppies from a PC that has a CD-ROM. You can make installation
disks that install the program using a Windows application (this works on all PCs with Windows
3.x, 95, 98 or Windows NT) or you can make DOS only installation disks.

Page 20: Step 4: Install Dkadmin
Existing 280Admin customer data can be used with DKAdmin Release 4.XX. Note DKAdmin
software is also available from the Toshiba FYI Internet site. Windows PC from CD-ROM Notes
When installing DKAdmin to run as a DOS session in Windows NT, the install program assumes
that the default directory name (WINNT) and the default system drive (Drive C) contain the
system files.

Page 21: Dos Only Pc From Cd-Rom
1. Insert the DKAdmin Disk #1 into drive A: (or B:). 2. Using DOS, type: a:\install (or b:\install) at
the C: prompt and press Enter. The Toshiba Install DKAdmin System screen automatically
displays. Follow the prompts to install DKAdmin. 3. During installation, if you have an existing
customer file in an older version of DKAdmin (280Admin) on your PC, highlight the DKAdmin 4.0
Upgrade Installation...

Page 22: Step 5: Run Dkadmin Program
Hardware key Not Installed. Exiting to DOS. OK. Install the DKAdmin hardware key, then retry
running the program. 1. Once the Toshiba Title screen displays, press any key to continue. This
message appears: Please Enter Your User ID: 2. Type Master and press Enter. This message
appears: Please Enter Your Password.
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Page 23: Set Windows Dkadmin Program Properties
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– 6. Highlight Yes and press
Enter. If you choose No, your new passwords are not installed on the disk. 7. A “Copy to Drive”
dialog box displays. The box defaults to drive A:. If you do not want drive A:, type the drive
letter to which you wish to copy the installation information. Press Enter.

Page 24 Step 5: Run DKAdmin Program
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– 6. From Advanced Program
Settings screen (shown at right), check only the Suggest MS-DOS mode as necessary option.
Click on OK. Note Other screen settings should not be selected. 7. Select the Memory Tab
screen (shown at right).

Page 25: Step 6: Connect To The Strata Dk Telephone System
Page Step 6: Connect to the Strata DK Telephone System To program or update a Strata DK,
you must be connected to the Strata DK telephone system. For procedures on connecting your
PC to the Strata DK, see Connecting to Strata...

Page 26 Step 6: Connect to the Strata DK Telephone System
––––––––––––––––––––––––––––––––––––––––––––––––––– DKAdmin/DKBackup...

Page 27: Chapter 3 - Installing Dkbackup
Installing DKBackup Step 1: Check System Requirements For optimum performance, run
DKBackup on a personal computer with the following minimum specifications: IBM-compatible
386/486 personal computer or higher level 20MB or larger hard drive CD-ROM or 3.5" 1.44KB
high-density floppy drive DKBackup software is distributed on a CD-ROM disk.

Page 28: Step 2: Power Up Dkbackup Pc
Step 2: Power Up DKBackup PC
–––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– From C:\280BCKUP\Data, type
del *.ntx and press Enter. From C:\280BCKUP\XXX.DK, type del *.ntx and press Enter. Run
“ReIndex Files” under Options/System Utilities Menu each time before you start to use
DKBackup. Always exit DKBackup before you turn your computer off. Step 2: Power Up
DKBackup PC Note The DKBackup or DKAdmin Hardware Key must be installed on the PC LPT1
port,...

Page 29: Step 3: (Optional) Make Installation Floppy Disks
––––––––––––––––––––––––––––––––––––––––––––––––––––– Step 3: (Optional) Make Installation Floppy
Disks From Windows If you wish to install DKBackup on a PC that does not have a CD-ROM, you
will need to make installation floppies from a PC that has a CD-ROM. You can make installation
disks that install the program using a Windows application (this works on all PCs with Windows
3.x, 95, 98 or Windows NT) or you can make DOS only installation disks.

Page 30: Step 4: Install Dkbackup
Existing 280Backup customer data can be used with DKBackup Release 4.XX. Note DKBackup
software is also available from the Toshiba FYI Internet site. Windows PC from CD-ROM Notes
When installing DKBackup to run as a DOS session in Windows NT, the install program assumes
that the default directory name (WINNT) and the default system drive (Drive C) contain the
system files.

Page 31: Dos Only Pc From Cd-Rom
1. Insert the DKBackup Disk #1 into drive A: (or B:). 2. Using DOS, type: a:\install (or b:\install)
at the C: prompt and press Enter. The Toshiba Install DKBackup System screen automatically
displays. Follow the prompts to install DKBackup. 3. During installation, if you have an existing
customer file in an older version of DKBackup (280Backup) on your PC, highlight the DKBackup
4.0 Upgrade Installation...

Page 32: Step 5: Run Dkbackup Program
Hardware key Not Installed. Exiting to DOS. OK. Install the DKBackup hardware key, then retry
running the program. 1. Once the Toshiba Title screen displays, press any key to continue. This
message appears: Please Enter Your User ID: 2. Type Master and press Enter. This message
appears: Please Enter Your Password.
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Page 33: Set Windows Dkbackup Program Properties
–––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– 5. After completing your
password setup, press Esc. The message Do You Want To Copy User File Back On The
Installation Disk? displays. 6. Highlight Yes and press Enter. If you choose No, your new
passwords are not installed on the disk.

Page 34 Step 5: Run DKBackup Program
–––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– 6. From Advanced Program
Settings screen (shown at right), check only the Suggest MS-DOS mode as necessary option.
Click on OK. Note Other screen settings should not be selected. 7. Select the Memory Tab
screen (shown at right).

Page 35: Step 6: Connect To The Strata Dk Telephone System
Page Step 6: Connect to the Strata DK Telephone System To program or update a Strata DK,
you must be connected to the Strata DK telephone system. For procedures on connecting your
PC to the Strata DK, see Connecting to Strata...

Page 36 Step 6: Connect to the Strata DK Telephone System
––––––––––––––––––––––––––––––––––––––––––––––––––– DKAdmin/DKBackup...

Page 37: Chapter 4 - Using Dkadmin/Dkbackup
CD 280ADMIN and press Enter. 2. From the C:\280ADMIN prompt, type dkadmin and press
Enter. The Toshiba start-up page displays (shown right). 3. Type your User ID and press Enter.
4. Type your password and press Enter. Using DKAdmin/DKBackup Appendix A –...

Page 38 Logging On
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– If you have
entered your User ID and password correctly, the DKAdmin Main Menu displays (shown right).
All DKAdmin activity originates from the DKAdmin Main Menu. The three items across the
DKAdmin Main Menu bar (i.e., File, Administration, Options) enable you to perform the many
functions shown in not be available for selection, depending on your assigned User ID and
password.

Page 39 Options System Installation Systems Utilities Figure 4 DKAdmin Main Menu Options
Using DKAdmin/DKBackup Telephone Flexible Button Assignments Add-on Module Button
Assignments DSS Console Button Assignments Attendant Console Flexible Button Assignments
System Speed Dial Numbers Station Speed Dial Numbers ACD Programs...

Page 40: Dkbackup
C:\ prompt type CD 280BCKUP and press Enter. 2. From the C:\280BCKUP prompt, type dkbckup
and press Enter. The Toshiba start-up page displays (shown right). 3. Type your User ID and
press Enter. 4. Type your password and press Enter.

Page 41: Keyboard Conventions
–––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– File Select Customer
Maintain Customer File Dial DK Hangup Connection Transfer DK Data About Exit Backup Check
Processor Type Backup/Restore Data View/Print Data Options System Installation Systems
Utilities Figure 5 DKBackup Main Menu Options Keyboard Conventions While working within
DKAdmin/DKBackup, you can use the following keys to: Page Up/Page Down Enter Left/Right
Arrow...

Page 42: Using The Pull-Down Menus
Using the Pull-Down Menus
–––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– Using the Pull-Down
Menus You can perform all basic operations from the Main Menu’s menu bar. When you select
an item in the menu bar, a “pull-down” options menu appears, listing all the functions which
you can perform (shown right). To use a pull-down menu 1.

Page 43: Logging Off
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– Logging Off
To exit the DKAdmin/DKBackup system 1. Return to the DKAdmin/DKBackup Main Menu by
pressing Esc until the Main Menu displays. 2. Highlight the File Menu option and press Enter, or
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type f. 3. Highlight Exit and press Enter, or type x. DKAdmin/DKBackup shuts down and returns
the screen to a DOS prompt.

Page 44 Logging Off
–––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
DKAdmin/DKBackup...

Page 45: Chapter 5 - File Menu
3. If you will be Uploading/Downloading data between the DKAdmin PC and a Strata DK and you
must dial via modem or Toshiba DIU to connect, use the Dial DK option to select and dial the
customer; or, connect the DKAdmin PC directly to the DK system (see Appendix A –...

Page 46: For A New Customer
Maintain Customer File
–––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– For a New Customer
To quickly use DKAdmin with a new installation of Strata DK 1. Create a new customer record,
using the Maintain Customer File option from the File Menu. 2. Select the newly created
customer, using the Select Customer option from the File Menu. 3.

Page 47 Enter the three character foreign country telephone code. Phone No., Ext Enter the
customer telephone number (of the customer contact), including area code, and extension. This
telephone number does not automatically dial out when using the Dial DK option and is only
used as a reference for the customer telephone number.

Page 48 Maintain Customer File
–––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– Customer File
Maintenance Screen Fields (continued) Table 2 Field Description Enter the After Connect String
when calling into a Strata DK modem pool (see After Connect Figure 20 the After Connect string
(where YYY is the extension number of the PDIU-DS connected to the Strata DK TTY port).

Page 49: Select Customer
If you are uploading/downloading data between the DKAdmin/DKBackup PC Important! and a
Strata DK and you must dial via modem or Toshiba DIU to connect, use the Dial DK option to
select and dial the customer. If the PC is connected directly to...

Page 50: Dial Dk
Dial DK The DKAdmin/DKBackup to Strata DK communications link can be made via modems,
Toshiba PDIUs or RPCIs, using the DKAdmin/DKBackup dialing strings (DIU, modem, and/ or
After Connect). Dialing strings are not necessary if the DKAdmin/DKBackup PC is connected
directly to the Strata DK TTY Port (see Customer or Dial DK menus.

Page 51
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
Important! In order for the DKAdmin/DKBackup Backup/Restore Data option to operate if you
are using an IMDU or RMDS modem, Program 77-1, LED 14 must be “ON.” (See Prg 77-1 LED 15
for RMDS bps rate in the Strata DK Programming Manual.) The DKAdmin/DKBackup hardware
key (green or red) must be installed whenever using the DKAdmin/DKBackup program (see the
figure in Substep 6 on Page 2-4).

Page 52: Hangup Connection
Hangup Connection
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– 3. Pressing Enter
from the last field on the screen, saves the new information and returns you to the Customer
List screen. Pressing Esc, exits the screen without saving the changes and returns you to the
Customer List screen. Hangup Connection To close the DK communications link 1.

Page 53: Chapter 6 - Administration Menu (Dkadmin)
Administration Menu (DKAdmin) The Administration Menu is only available in the DKAdmin
program. The Check Note Processor Type, Backup/Restore Data, and View/Print Data appear in
both the DKAdmin Administration Menu and the DKBackup Backup Menu. These functions are
identical (e.g., screens, operations, commands, etc.) whether you use DKAdmin or DKBackup.
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Page 54: View Cabinet Diagram
Logical ports assignments Telephone locations PDN/Intercom numbers DID numbers LCD user
names Voice mail forward ID codes Voice mail message waiting codes System speed dials
System messages Station attributes (40 individual telephone options) “Check Processor Type”
Page 100. DKAdmin/DKBackup...

Page 55 For each physical port, you can: Enter the location (room or office name) of each
telephone or device connected to the Strata DK. Transfer telephone attributes to another
telephone by changing the logical port number.

Page 56: Programming/Updating System
Programming/Updating System To program or update the entire system or an individual port 1.
Highlight the Telephone Location field of the physical port with which you wish to work. Enter
the physical telephone location (for example, main conference room, VP office, lunch room,
etc.).

Page 57: Printing Port/Station Information (F3)
The DID numbers for the range of ports you specified are changed if you enter Yes. 6. Highlight
the Telephone LCD User Name field. Enter the name of the user assigned this physical port ...or
if you prefer, you may use DNs/intercom numbers in this field rather than names.

Page 58: System Speed Dial Number (F7)
3. Highlight the System Speed Dial Memo field and enter a description of the speed dial number
(up to 12 characters). This memo displays on the telephones LCD when the Bin Number is
selected by an LCD telephone, using the MODE 8XXX function (where XXX is the speed dial bin
number).

Page 59: System Lcd Messages (F8)
To set or change available system LCD messages Note You may create up to 40 system
messages which may be used by all LCD telephone ports. Each message may contain two lines
using up to 32 characters. 1. From the System/Station Administration Screen, press F8.

Page 60 Initialized data enables all speakerphones. MIC Key Lock An electronic or digital
telephone microphone can be turned on or off by using the Mic Enabled button. A button lock
operation enables an alternate action Push On/Push Off of the Mic button.

Page 61 (Toshiba digital or electronic) can be assigned to receive all call page. BOV Tone If a
digital or electronic telephone [DN] is busy and it receives a call on an idle [DN] or CO (Off = 2
Beeps, button from another station or an outside line, the telephone receives two muted-ring...

Page 62 Hold Display Disables/enables the Hold Display Scroll feature independently for each
telephone. When Scroll more than one call is on hold on a telephone, the Hold Display Scroll
feature enables a (On=Enabled) user to scroll through the held lines. Key 13-TR/14-TR...

Page 63 Area Code Tables and Office Code Tables. If T.R. Digit Restriction is enabled, a
station cannot dial digits after dialing a telephone number. Station T.R. Each of the Toll
Restriction classes established in Program 46 can be assigned a code Restriction with this
program.

Page 64 System/Station Administration
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– Flexible Button
Assignments (F5) To view or change flexible button assignments 1. Press F5 from the Port
Attributes screen and the Port Flexible Key Assignments screen displays (shown right). 2. To
change a flexible button assignment, highlight the Flexible Key Assignment and press: F5–Pause
to...

Page 65 –––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– 4. Press Ctrl+F2
again. A pop-up dialog box displays (shown at right). 5. Type the desired ports and press Enter.
Another pop-up dialog box displays asking you confirm the change. 6. Highlight Yes and press
Enter to make the change or No to cancel the changes. 7.
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Page 66: Saving/Uploading Programmed Data (F9)
System/Station Administration
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– System Messages (F8) To
assign system messages Press F8 from the Port Attributes screen. The Port Personal Messages
screen displays (shown right). Refer to Page 49 procedures. Saving/Uploading Programmed
Data (F9) To upload programmed data After completing your programming, press F9 to save the
information and begin the uploading process.

Page 67 052~059 060~067 009~016 017~924 RCOS ACD/MIS 8-TDGL CUSTOMER NAME
System Speed Dial System System Speed Dial Number Speed Dial Memo 17145833700
TOSHIBA 13124675889 CHICAGO 1723727173721 NEW YORK 4773938 DOWN 4737473 TOWN
4789994 DEALER A 434... DEALER B CUSTOMER NAME System Messages...

Page 68 VA - Vacant Port (Prog 03, code DO) PT - Port Type This is a test field in which the
location of the physical port wiring termination point (telephone jack) may be entered. Logical
Port associated with physical port. Intercom number associated with logical port.

Page 69 Station Speed Dial/Memos by Station (prints out with current port attributes)
Administration Menu (DKAdmin) CUSTOMER NAME Feature Description Attribute 20-Button (A)
Telephone Keystrip Type Ring Tone Volume Level Speakerphone Enabled MIC Key Lock Enabled
CUSTOMER NAME Flexible Key Assignment ACD - End of Shift...

Page 70 System/Station Administration
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– Intercom 202/Port 002
Personal Messages for BRIAN No: 202 Personal Message Number Figure 14 Station Personal LCD
Messages by Station (prints out with current port attributes) Intercom 202/Port 002 CO Line
Information for BRIAN No: 202 Line 81 - Program 81 - DAY Immediate Ring 82 - Program 82 -
DAY 12 Second Delay Ring 83 - Program 83 - DAY 24 Second Delay Ring...

Page 71: Flexible Button Programming Section
Administration Menu appears. 2. Type u and the Flexible Key Program Administration screen
displays (shown right). Telephone Flexible Button Assignments To access the option Press Enter
and the Telephone Flexible Button Key Assignments screen displays (shown right). This screen
enables you to...

Page 72 Flexible Button Programming Section 3. Press F2 to make the key a Primary DN, F3 a
Secondary DN, F4 a Phantom DN, or F6 to change the key feature. If you press F3 or F4, a pop-
up list appears and you must enter a primary or secondary number.

Page 73: Add-On Module Button Assignments
–––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– 4. Press Ctrl+F2 again. A pop-up
dialog box displays (shown at right). 5. Type the desired ports and press Enter. Another pop-up
dialog box displays asking you confirm the change. 6. Highlight Yes and press Enter to make the
change or No to cancel the changes. 7.

Page 74 Flexible Button Programming Section To copy the features from one port to another
1. Highlight the LED you wish to copy and press F4. The Copy to Port dialog box displays. 2.
Type the range of port numbers that you wish to copy TO. 3.

Page 75: Dss Console Button Assignments
–––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– To assign more than one speed
dial number 1. Follow the procedure for changing an assigned feature and assign a
station/system speed dial number. 2. Press F8– + SD to add additional speed dial key
assignments. Important! You can only use this key when you are assigning more than one
speed dial key at a time.

Page 76: Attendant Console Flexible Button Assignments
Flexible Button Programming Section The selected feature replaces the previous feature. Notes
You can only assign a feature to one button within a console. If you attempt to assign a feature
already assigned, an error message displays. Press F8–Increment SD to add additional speed
dial key assignments. Important! You can only use this key when you are assigning more than
one speed dial key at a time.
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Page 77 –––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– To edit your attendant
console flexible button assignments 1. Highlight the key assignment you wish to change and
press F6. A feature pop-up list displays (shown right). 2. Use the +/- keys or the Page Up/Page
Down keys to scroll through the list.

Page 78: Speed Dial Programming Section
40 for TMAU and RCTUA processors. 2. Highlight the System Speed Dial No. field and type the
speed dial telephone number, including area code, and press Enter. 3. Highlight the System
Speed Dial Memo field and enter a description of the speed dial number (up to 12 characters).

Page 79: Station Speed Dial Numbers
4. Highlight the Speed Dial Memo field and enter a description of the speed dial number (using
up to 12 characters). This memo displays on the telephones LCD when the Bin Number is
selected by an LCD telephone using the MODE 8XXX function (where XXX is the speed dial bin
number).

Page 80: Acd Administration
ACD Administration
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– The DKAdmin PC
must be connected to the Strata DK to upload any CAUTION! changes to this data (see
procedures on connecting the DKAdmin PC to a Strata DK). 6. Press Esc to close the System &
Station Speed Dial Administration screen and return to the Main Menu.

Page 81 –––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– 2.
Highlight the program number and press F3. The Edit Program screen displays (shown right).
The screen varies, depending upon the program selected. You can also use Note the Find
function to quickly move to a program by typing the first digit of the program number.

Page 82: Acd Agent Programs
ACD Administration
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– 5. Follow Step 2
Step 4 ACD Agent Programs To edit ACD agent programs 1. Highlight the ACD Agent Programs
option and press Enter. The ACD Agent Programs screen displays (shown right). This screen
enables you to edit ACD Agent programs.

Page 83: Program Administration Section
LCR Programs Multiple Directory Number Programs ANI Programs DNIS Programs DKT/RPCI/OA
Interface Programs Class/Caller ID Programs Distributed Hunt Programs Call Park Programs Off
Hook Call Announce Programs Standard Telephone MW/Camp-on Tone Programs Enhanced
911/CAMA Trunk Programs ISDN Programs Initialization Programs...

Page 84: View All Programs (Download, Edit, Upload)
Program Administration Section
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– After selecting the program,
you have the following options: Press F2 to pull the program data from the DK. See procedures
on downloading data. Press F3 to edit the program. Only programs displaying a check mark may
be edited by your password level.

Page 85 ––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– To edit a program
1. Press F3 and the Directory Numbers Assignments screen displays (shown right). 2. Highlight
the logical port number and press F2 to reset the DN for the logical port numbers on a range of
ports. 3.

Page 86 Program 39, select and edit Program 38 using Program Administration. To change a
keystrip to a default value in Program 38 and overwrite Program 39 data, select and edit
TELEPHONE KEYSTRIP TYPE (PRG38) from the System/Station Administration-PORT ATTRIBUTES
screen for the selected station port.

Page 87: Security Maintenance Section
–––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– Security Maintenance
Section The Security Maintenance Section option (level 9 password required to access this
option) enables you to set up to three levels of security using: Passwords - defines the functions
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available to users using menu-specific passwords as described on Page Program Access -
defines the programs which can be used by each password level using...

Page 88: Program Security (Default Levels)
Security Maintenance Section
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– The password levels (0 ~
9) are based on a hierarchal system. This means that Note password level 9 has access to all
programs, but password level 5 (for example) has access to all programs tagged with 5 and
below, but not 6 and above. Program Security (Default Levels) Program security is maintained
by assigning access levels to each program.

Page 89 –––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– Strata DK
Program Security (continued) Table 6 Strata DK Security Level Program *11-8 14-1 14-2 41-1
41-2 41-3 41-4 42-1~2 *43-1~3 45-1 45-2 45-3 *61-1 *61-2 *61-3 *62-1 Administration Menu
(DKAdmin) Program Title 911 Special [DN] Notification Assignments (R4) ANI Station Information
(R4) Station Group Information (R4) Auto Answer with Zip Tone Assigned to Agent ID...

Page 90 Security Maintenance Section
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– Strata DK Program
Security (continued) Table 6 Strata DK Security Level Program *62-2 *62-3 *64-1 *64-2 *66-1
*66-2 *66-3 *66-4 *66-5 *66-6 *66-7 *67-1 *67-2 *67-3 *67-4 *68-1 *68-2 *69-1 *69-2 Program
Title Non-ISDN Station Outgoing Call Pad Level (R4) Non-ISDN Station Incoming Call Pad Level
(R4) ISDN Dialing Parameters (R4) Direct Inward Dialing Parameters (R4)

Page 91 Primary Auto Attendant Announcement Device Assignments Secondary Auto
Attendant Announcement Device Assignments Incoming Auto Attendant Call Overflow Time
Built-In Auto Attendant Camp-On Busy Time Digital Telephone Handset Receiver Volume Level
DSS Console/Attendant Telephone Assignments DSS Console Button Assignments Security
Maintenance Section...

Page 92 Hold/Park Recall Timing Station Class of Service Fixed Call Forward (Voice Calls Only)
CO and TIE Line Ring Transfer (Camp-on) Recall Time Digital and Electronic Telephone Keystrip
Type Flexible Key Assignment Button Codes Station CO Line Access Station Outgoing Call
Restriction...

Page 93 Open Architecture Interface Attributes (R3.2) CO Line Special Ringing Assignments:
DSS/IMDU, Night Ringing Door Phone Ringing Digital & Electronic Telephone Ringing Tones (CO
Line Calls) CO Line/Station Ringing Assignments (DAY Immediate) CO Line/Station Ringing
Assignments (DAY 12-Second Delay) CO/Line/Station Ringing Assignments (DAY 24-Second
Delay)

Page 94 Security Maintenance Section
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– Strata DK Program
Security (continued) Table 6 Strata DK Security Level Program 91-1 91-2 91-9 92-1 92-2 92-3
92-4 92-5 92-9 Program Title CO/Line/Station Ringing Assignments (DAY 2 12-Second Delay)
CO/Line/Station Ringing Assignments (DAY 2 24-Second Delay) CO/Line/Station Ringing
Assignments (NIGHT Immediate) CO/Line/Station Ringing Assignments (NIGHT 12-Second Delay)
CO/Line/Station Ringing Assignments (NIGHT 24-Second Delay)

Page 95: Directory Number Administration
–––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– Directory Number
Administration Note This option cannot be used by Strata DK Release 2 or below. To maintain
your directory number assignments for both your PDNs and PhDNs 1. Press r and the Directory
Number Administration screen displays (shown right). This screen enables you to assign and
change PDN and PhDN user...

Page 96 Directory Number Administration
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– to change the range of
numbers used for all the ports, press F5. A pop-up box displays, enabling you to specify a range
of numbers. Type the desired range of Port Reference Numbers for the PDNs (000 ~ 079). Type
the desired range of Port Reference Numbers for the PhDNs (500 ~ 579).

Page 97 –––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– 4. Highlight the
24s Dly field for the desired DN. The spacebar toggles the field between enabled and disabled.
When the field is enabled a check mark is displayed in the field and a 24-second delay before
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ringing occurs. You cannot enable both the 12s Dly field and the 24s Dly field.

Page 98 Directory Number Administration
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– To set/change CO Line
flexible key assignments 1. From the Directory Number for Primary DN XXX screen, highlight a
[DN] and press F5. The Flexible Key Assignments screen for the selected Port/DN displays
(shown right). 2. Highlight the desired Flexible Key Assignment and: Press F2 to change...

Page 99: Dnis Administration
–––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– DNIS Administration
Note This option cannot be used by Strata DK Release 2 or below. This option enables you to
maintain assignments for your DNIS/DID/ANI lines, change or add number/name/ringing/voice
mail ID assignments, or network tables and tenant locks specifications.

Page 100: Dnis Number/Name/Ringing/Vm-Id Assignments
DNIS Administration ––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
Each field has only two selections. Use the spacebar or +/- keys to toggle between Note them.
Field Tie Line Voice & Page Tie/DID Wind/Immed DID Line Camp On Busy DID/Tie Line Second
Dial Line 3. Repeat Step 2 for each tie/DID line you wish to set/change. 4.

Page 101: Dnis Network Table Assignments
DNIS Network Table Reference number with which you wish to work. 3. Type the CO line access
code and network telephone number, using up to 27 digits and press Enter. To remove an entry,
with the field highlighted, press F4.

Page 102: Dnis Tenant Lock Assignments
Distributed Hunt Group Administration DNIS Tenant Lock Assignments To set/change passwords
for station port numbers 1. Select the DNIS Tenant Lock Assignments option and press Enter.
The DNIS Tenant Night Lock Assignments screen displays. This screen (shown right) enables you
to set/change passwords for station port numbers for each of...

Page 103: Call Forward Assignments
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– 3. Type a DH Group [DN]
(up to four digits) and press Enter. If the entered number conflicts with a DN/Port already
assigned, an error message displays. 4. Highlight the Hunt PDN 01 field. Type the hunt [PDN]
number and press Enter ...or press F6 to select the number from a table.

Page 104: E911/Cama Trunk Programs (R4 Only)
10 provides two assignable RSTU, KSTU2, RDSU, PSTU, or PESU ports to interface with Central
Office (CO) E911 trunks. This program is only used when CAMA trunks are connected to an E911
adjunct interface box, not when using Toshiba RMCU/RCMS CAMA trunks.

Page 105 Programs 10-11 and telephone ports are connected to the E911 interface unit.
Program 04 Directory Number data must be blank for E911 RSTU-KSTU2 ports. Program 10-91
assigns the time allowed to dial each digit after dialing 9 when using the E911 feature.

Page 106 E911/CAMA Trunk Programs (R4 Only) To use the Strata DK’s program files to edit
1. Press F2 and the DK Code dialog box displays. 2. Type the DK Code: XXXX, where XXXX is the
DK level 1 security code set in Program 00.

Page 107: Isdn Programs (R4 Only)
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– ISDN Programs (R4 Only)
Note This option cannot be used by Strata DK Release 3 or earlier. The Integrated Services
Digital Network (ISDN) Programs option in the Administration Menu enables you to maintain
ISDN programs. Release 4.0 provides the Primary Rate Interface (PRI) ISDN capabilities. Release
4.1/4.2 will introduce the ISDN Basic Rate Interface (BRI).

Page 108: Backup/Restore Data
Backup/Restore Data –––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
If the Problem: Unable to Establish Communications screen Note displays, follow the
troubleshooting steps on the screen and/or refer to Connecting to Strata DK 3. Press F2 to select
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(tag) all Program No. (data) files. 4. Highlight Yes and press Enter. DKAdmin establishes
communications to the Strata DK, turns on LED 10 in Program 77-1, and receives data blocks.

Page 109: Chapter 7 - Backup Menu (Dkbackup)
The .DK extension is automatically added by DKAdmin/DKBackup when creating the directory in
DOS. The Strata DK programming telephone (station 205 or 213) cannot be in the programming
mode when backing up or restoring Strata DK program files. Anytime PRGALL is restored to a
Strata DK, system power must be turned OFF (3 seconds) and then ON.

Page 110: Check Processor Type
If the PC and Strata DK do not communicate, the Problem: Unable to Establish Communications
screen appears. Follow the instructions on the screen and/or see Appendix A – Connecting to
Strata DK Make sure the programming telephone (station 205 or 213) is not in the programming
mode. Backup Data Prior to backing up 1.

Page 111 All Station and System Speed Dial Memos All Station and System LCD Messages
Directory Number Call Forwarding settings (R3) Message Waiting Lamp settings (R3) Caller
ID/ANI Lost Call telephone numbers (R3) -(Un)Tag All -Backup Esc-Exit 3. The screen displays
Download Complete when finished.

Page 112: Restore Data
PC and Strata DK is broken during Backup or Restore operations, it may be necessary to go in
and out of the Program mode from the programming telephone (Station 205); or turn the Strata
DK power off and on to resume communications.

Page 113 PC COM port is connected to the Strata DK PIOU, RSSU, RSIS, RSIU or PIOUS TTY
port, or IMDU or RMDS modems. Make sure the programming telephone (station 205 or 213) is
not in the programming mode if communications are not established.

Page 114 RSIS/RMDS TTY port that is connected to DKAdmin PC by performing Step B and/or
C. Step B: From the Programming Telephone, use Program 03 to set code 41 for the cabinet slot
that contains the new TTY/Maintenance PIOU, PIOUS, or RSSU PCB and proceed to Step D. If you
added an RSIU/...

Page 115 Selection screen displays (shown below). This screen enables you to set the
DKAdmin/ DKBackup PC COM port baud rate which must match the baud rate of the TTY or
modem port set by the programming telephone. Please adjust the baud rate of DKBackup PC
COM port to match the new PIOU, PIOUS, RSSU or RSIU/RSIS you may have installed.

Page 116 Restore Data
–––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– 9. After
reading the screen in Step 7, press Enter. The screen below displays. Program No. PRGALL
REPALL NAMEALL VIDALL Pull Program 03 from DK to Update Customer Database? 10. Highlight
Yes and press Enter. You are prompted for the DK Code. 11.

Page 117: Upgrade
You may change the DK security code using the DKAdmin Program Administration Section
option or manually from the programming telephone. When uploading Program 35 or PRGALL,
DKAdmin will pull MSGALL and ADMEMOAL to update any changes in Program 35, LED 05.

Page 118 Upgrade
–––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– When
upgrading from an RCTU Release 1 or 2 to an RCTU Release 3 or above, DKAdmin/DKBackup
automatically converts Program 39 intercom code (000) to the appropriate Primary Directory
Number code (##XXX) for each station port. When upgrading from DK16e and RCTUA to RCTUB
or C/D (all releases), System Speed Dial numbers and buttons (060~099) are upgraded to
(660~699).

Page 119 All Voice Mail Message Waiting Codes (#657) All Station and System Speed Dial
Memos All Station and System LCD Messages Directory Number Call Forwarding settings (R3)
Message Waiting Lamp settings (R3) Caller ID/ANI Lost Call telephone numbers (R3) -(Un)Tag All
-Backup Esc-Exit Processor Conversion...
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Page 120 Upgrade
–––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– 8. Press
Enter and then select the processor type you are upgrading to; press Enter after selecting the
processor (RDTU E/F, Release 3 in this example). 9. If you haven’t backed up the customer
database by downloading the original RCTU, answer Yes to Backup From DK First;...

Page 121 RSIS/RMDS TTY port that is connected to DKAdmin PC by performing Step B and/or
C. Step B: From the Programming Telephone, use Program 03 to set code 41 for the cabinet slot
that contains the new TTY/Maintenance PIOU, PIOUS, or RSSU PCB and proceed to Step D. If you
added an RSIU/...

Page 122 Upgrade
–––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– 16. Select
the DKAdmin/DKBackup PC COM port baud rate and press Enter. The information screen below
instructs you to pull Program 03 if you changed any PCBs during the upgrade process.
DKAdmin/DKBackup can be used to pull Program 03 automatically.

Page 123 4. Program each Agent phone as the owner of its ACD call button PhDN (PRG 33).
29. Perform the steps displayed on the screen as required, using the programming telephone,
and backup any data that you change, using DKAdmin/DKBackup. 30. Press Esc twice to return
to the Main Menu.

Page 124 PC’s memory and takes a long time to back up and restore. Toshiba recommends
using an MS-DOS edit program to edit out all lines of backed-up data (in each file) that do not
contain actual speed dial numbers, user names, etc.

Page 125: View/Print Data
–––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– one at a time
(for example: PRGALL), instead of tagging all files to download. If a Release 1 processor fails
during the downloading process, retry the process or change the original Release 1 processor
ROMs to NANP Release 1 upgrade ROMs and then download.

Page 126 View/Print Data
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
DKAdmin/DKBackup...

Page 127: Chapter 8 - Options Menu
Options Menu This chapter gives you step-by-step instructions on using the options available on
the Options Menu. They are: System Installation Company General Information (DKAdmin only)
Screen Type/Color Installation Printer Type Selection System Miscellaneous Variables User
Password Level Setup Communications Setup System Utilities ReIndex Files System
Installation...

Page 128: Screen Type/Color Installation
System Installation –––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
Screen Type/Color Installation To change your monitor or color setups (not available to
password level 2) 1. From the Main Menu, type o. The System Installation Submenu displays
(shown right). Press Enter. 2. Type s and a pop-up screen displays (shown right), enabling you
to set monitor and screen specifications.

Page 129: Printer Type Selection
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– To change the
color of an item 1. From the pop-up dialog box, highlight the Yes for the Change Colors option
and press Enter. The Color Selection screen displays. The Color Selection screen (shown right)
consists of an item selection menu, a set of item color bars, and a sample screen...

Page 130: System Miscellaneous Variables
System Installation –––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
To select printer 1. Type p. The Printout Destination Selection Matrix screen displays (shown
right). 2. Highlight the appropriate printer destination and press the spacebar. The highlighter
moves to the Printer field. 3. Press F2. The Available Printer Drivers dialog box displays.
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Page 131: User Password Level Setup
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– Proper Case
Conversion Shift-Function Keys Background Char 3. When you have completed your selections,
press Enter. A Save Parameters pop-up box displays. 4. Press Enter to save the entries and
return to the System Installation Submenu. User Password Level Setup The User Password Level
Setup option (available to password level 9) enables you to control access to certain
DKAdmin/DKBackup features through the assignment of menu-specific passwords.

Page 132 System Installation
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– To add users and
assign passwords Table 7 for a list of password access levels for each menu option available in
the Note DKAdmin/DKBackup programs. 1. Highlight the User ID field and press Ins. A pop-up
dialog box displays enabling you to enter new user ID information.

Page 133 ––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– Table
7 Password Level Menu Access File Menu Select Customer Maintain Customer Dial DK Hangup
Connection Transfer DK Data About Exit Administration/Backup Menu* View Cabinet Diagram
Check Processor Type* System/Station Administration Flexible Key Programming Section Speed
Dial Programming Section ACD Administration Section Program Administration Section Security
Maintenance Section...

Page 134: Communications Setup
System Installation –––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
Password Level Menu Access (continued) Table 7 Communications Setup Reindex Files To
change user or password information for an existing user 1. Access the Password File
Maintenance screen (under the User Password Level Set Up option). 2. Highlight the user you
wish to change and press Enter to display the user information. 3.

Page 135: System Utilities
–––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– To display the
communication settings 1. Type o. The Option Menu displays. 2. Type i. The System Installation
Submenu displays. 3. Type o. The Communications Setup screen displays (shown right). 4. To
change the Communication port, press Enter. A pop-up ports window displays.

Page 136 System Utilities
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
DKAdmin/DKBackup...

Page 137: Appendix A - Connecting To Strata Dk
The DKAdmin/DKBackup PC is required to edit or change a Strata DK customer database file
with or without being connected to a Strata DK telephone system. A PC equipped with
DKAdmin/DKBackup enables you to upload, download, upgrade and/or edit complete Strata DK
databases.

Page 138: Piou/Pious/Rssu/Rsiu Setup
DKAdmin/DKBackup PC directly connected to the Strata DK – 50 feet maximum (see Figure 16
Page DKAdmin/DKBackup PC connected to Strata DK via Toshiba Data Interface Units – 1000
feet maximum (see DKAdmin/DKBackup PC remote modem connected to Strata DK system
external...

Page 139: Calling Strata Dk Using The Dialer
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– Calling Strata DK Using the
Dialer The DK Dialer is used only to establish a modem-modem or DIU to DIU/modem
connection between the DKAdmin/DKBackup PC and the DK maintenance modem. The DK Dialer
is not used when connecting the DKAdmin/DKBackup PC directly to the Strata DK TTY port. To
call Strata DK using the dialer 1.

Page 140: Direct Connection To Strata Dk
DKAdmin/DKBackup PC Directly Connected to Strata DK—50 ft. Maximum Important! DK Dialer
Setup is not required for direct connection. Connection is always established; select customer
and proceed with Administration or Backup. 3-pair Modular Cord (Telephone type, cross-pinned)
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Customer Strata DK RSSU, RSIU, TSIU, WSIU Port...

Page 141: Connection To Strata Dk Via Toshiba Data Interface Units
LED 01, 02, and 17 ON for PDIU-DI or RPCI-DI Port Figure 17 DKAdmin/DKBackup PC Connected
to Strata DK Via Toshiba Data Interface Units—1000 ft. Maximum Customer Dialer Setup DIU
String: ATS2=43~~~ATDDYYY (YYY is the intercom or directory number of the PDIU-DS
connected to the TTY port) Note ~~~ must be entered to send the carriage return signal
following ATS2=43.

Page 142: Remote Modem Connection To External Modem/Tty Port
Customer Dialer Setup DIU string: (nothing) Modem string: ATDTX...X (X...X is the telephone
number of CO line that rings the external modem). After connect string: DK Security Code
(optional) To Make Connection 1. From the File Menu select the Dial DK and press Enter.

Page 143: Voice Call Transferred To Modem Connection
For some 14.4 or 28.8 fax modems, you may have to enter AT&Q6X3 D. After connect string: DK
Security Code (optional) Voice Call Transferred to Modem Connection PPTC25MDM (yellow) 3-
Pair Modular (Telephone type, cross-pinned) RS-232 External Modem Public Telephone Network
CO Line is used, put SW3 in the Modem position;...

Page 144: To Make Connection
1. From File Menu, type d. 2. Highlight the customer from the customer list. 3. At the remote
site, use the standard telephone (connected to the DKAdmin/DKBackup remote modem) to call
a telephone (or attendant console) at the customer site.

Page 145: Remote Modem Connection To Modem Pool
PDIU-DS (XXX) to PDIU-D (YYY) when it detects (connect 1200) that the remote modem has
connected to the external modem. Remote Modem Connection to Modem Pool 3-pair Modular
Cord (Telephone type, cross-pinned) PDIU-DS (YYY) CO LINE PPTC25MDM (yellow)

Page 146: To Make Connection
Remote Modem Connection to Modem Pool To Make Connection 1. From the File Menu select
Dial DK and press Enter. 2. Highlight the customer form the customer list. 3. Press F4 to
establish remote modem to external modem connection; the Modem Initialization String, the
Modem String, and the After Connect String will be sent from the DKAdmin/DKBackup PC COM
port.

Page 147: Pc Diu/Diu Modem Pool Connection To Strata Dk Modem
Remote Modem Pool RS232 Notes 1. Program 03 Code 62 or 64 for PDKU slot. 2. Program 39
The remote digital telephone must be equipped with the Data, Data Release, and Modem
buttons. Customer Strata DK Voice Path Data Path...

Page 148: To Make Connection
PC DIU/DIU Modem Pool Connection to Strata DK Modem To Make Connection 1. Select
Customer from the Dial DK Option. 2. Call attendant at customer Strata DK from remote digital
telephone (voice call using telephone handset). 3. From the remote digital telephone, press the
button LED flashes.

Page 149: Pc Diu/Diu Modem Pool Connection To Strata Dk Modem
(where XXX is the intercom or directory number of the PDIU-DS modem pool) Modem string:
ATDTY...Y (where Y...Y is the CO line access code plus the telephone number of the CO line that
will ring the IMDU or RMDS modem)

Page 150: To Make Connection
1. Highlight Customer from the Dial DK Option and press Enter. 2. Highlight the appropriate
customer, then press F3; the digital telephone DIU will connect to the remote modem PDIU-DS
and then the remote modem will go off hook and seize a CO line and dial the CO line which rings
the IMDU (normal ringing assignments in Strata DK Programs 81~89).
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Page 151: Pdiu-Ds Modem Pool Installation
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– PDIU-DS Modem Pool
Installation A B C Figure 23 External Modem to Strata DK TTY Port Connection To Make
Connection When connecting a PDIU-DS to a modem for modem pool operation (see set up the
PDIU-DS and modem per Steps 1 ~ 7 below. 1.

Page 152: External Maintenance Modem Installation
PDIU-DS will beep when a PDIU- DI connects to it. If LED 03 is ON, the telephone modem key will
indicate modem pool status but the PDIU-DS READY LED will always be off and the PDIU-DS will
not beep when a PDIU-DS connects to it.

Page 153 If the External modem is connected to a dedicated CO line, call the CO line number
to establish modem communication (see If the External modem is connected to a standard
telephone port, call a Strata DK CO line that can be transferred to (or programmed to ring) the
standard telephone modem port to establish modem communication.

Page 154 PDIU-DS Modem Pool Installation
–––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– PPCT (Modular to DB25)
Adaptor, Modified Wiring for Connecting TTY Jack to an External Modem (only if null-modem
adaptor is not used with PPTC): PIOU/PIOUS, TTY Jack Modular Pin Number 0926 * PPTC1A-5M,
pins 2 & 3 and pins 8 & 20 must be reversed in the field, as Important! shown, for modem
connection.

Page 155: Appendix B - Dk424 Rctue/F Upgrade Using Dkadmin
Upgrade Using DKAdmin This appendix discusses considerations and steps for upgrading the
Strata DK424 digital business telephone system to an RCTUE/F processor. DKAdmin software is
required to upgrade a DK14, DK16e, DK40 or any DK280/DK424 RCTUA, RCTUB, RCTUBA/BB, or
RCTUC/D database to an RCTUE/F processor.

Page 156: On-Site Upgrade
7. From the programming telephone, run Program 91-9 twice to initialize the RCTUE/F
processor. 8. From the programming telephone run Programs 03, 76, and 77-1 to set up the TTY
interface port. 9. Turn the system power off for five seconds then turn the power back on.

Page 157: Important Things To Do After Upgrading To An Rctue/F
Processor
8. From the programming telephone run Program 91-9 (twice) to initialize the RCTU E/F
processor. 9. From the programming telephone run Programs 03, 76, and 77-1 to set up the TTY
interface port. 10. Turn system power off for five seconds then turn power back on.

Page 158 Important Things to Do After Upgrading to an RCTUE/F Processor
–––––––––––––––––––––––––––––––––––––––– DKAdmin/DKBackup...

Page 159: Appendix C - Upgrading Strata Dk Systems To Dk424 Release
Upgrading Strata DK Systems to DK424 Release 4.0 The following important items must be
considered when upgrading the DK14, DK16e, DK40, DK280, and DK424 Release 1~3 systems
to a DK424 Release 4.0. A new feature in DK424 Release 4.0 is increased station capacity in
systems containing Tie and Direct Inward Dialing (DID) lines.

Page 160: Dk424 Release 4.0 Upgrade Procedure
DK424 Release 4.0 Upgrade Procedure DK424 Release 4.0 Upgrade Procedure 1. Using
DKAdmin or DKBackup Release 4.0, download the customer data from the currently installed
processor. Save this “Customer” data as a backup in case you must re- install the current
processor and/or processor ROM/Flash memory release level. Note You must use DKAdmin or
DKBackup Release 4.0 for this procedure.

Page 161: Upgrading Strata Dk Systems To Dk424 Release 4.0
–––––––––––––––––––––––––––––––––––––––––––––––––– Upgrading Strata DK Systems to DK424
Release 4.0 1. Power down the system before removing and installing the processor card(s).
shows the slot placement of the processor cards. 2. Remove only the RCTUA, RCTUBB, RCTUD,
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or RCTUF. 3. Remove the MOH connection, if required. RCTUBA RCTUC Slot R11...

Page 162 Upgrading Strata DK Systems to DK424 Release 4.0 Software Version R4 =
Heartbeat LED Upgrade Label RCTUBB4 Ribbon Cable to RCTUBA Figure 27 RCTUBB4 Printed
Circuit Board Software Software Software Version R4 = Version R4 = Version R4 = Upgrade
RCTUD4.X Label Figure 28...

Page 163 –––––––––––––––––––––––––––––––––––––––––––––––––– 5. Using a small screwdriver,
carefully remove the four ROMs or flash memory (see 30). 6. Replace with the equivalent ROMs
or flash memory in the upgrade kit. Peel the labels (two locations) off the card. Designates Front
of Chip (front) Front Direction Marker Silk-screened on PCB...

Page 164: Dk424 Release 4.0 Upgrade Programming Example
This example does not give you every program change required, nor does it attempt to instruct
you on how to re-program a system upgraded to Release 4.0, using the programming
telephone. This is a simple system upgrade; an actual installed systems can be much more
complex to upgrade.

Page 165: System/Station Administration Screen Before/After Release
4.0 Upgrade
–––––––––––––––––––––––––––––––––––––––––––––––––– System/Station Administration Screen
Before/After Release 4.0 Upgrade Figure 33 shows the DKAdmin System/Station Administration
Screen of the same DK424 Release 3 system shown in F4 with DKAdmin. The following table
summarizes the changes in RDDU in Slot 13 Port Range of PDKU2 in Slot 14 Slot 14 User Names,
PDNs, DID numbers, etc.

Page 166 DK424 Release 4.0 Upgrade Programming Example Phy. (Cabinet Port Telephone
Slot Location No.) LOBBY TELEPHONE ROOM KITCHEN FRONT OFFICE PLAY ROOM BACK ROOM
Figure 33 System/Station Administration Screen for RCTUE3/F3 Before Release 4 Upgrade Phy.
(Cabinet Port Telephone Slot Location No.)

Page 167: Program Changes Before/After Release 4.0 Upgrade
009 is swapped with port 013. Notice that before and after the upgrade, the Play Room
telephone is on the second PDKU circuit in slot 14 and to call the Play Room Telephone you
must dial 117 - making the upgrade transparent to the end user.

Page 168 Program 13 If the Message Center is the Front Office Telephone (PDN 112), data in
this program must be changed to adjust for port shifting caused by the RDDU DID line PCB in
slot 13 (see...

Page 169 Caller ID on a PC running a TAPI application, the data in Program 20 must shift.
This enables the Front Office Telephone and RPCI to operate the same way after the upgrade as
it did before. Notice that all Program 20 data for port 012 moves port to 008.

Page 170 DK424 Release 4.0 Upgrade Programming Example Program * 33 If the Back Room
telephone (PDN 119) is programmed as the Owner of PhDN 500, the data in Program * 33 must
shift: Before the Upgrade PhDN Port 500 is owned by Port 019 Programs 39, 29, * 29, and 59
When a port number shifts from XXX to YYY during an Release 4.0 upgrade, the following...

Page 171: Index
Index administration agent programs edit ACD programs edit agent programs , 71, view notes
on program ACD/DID assignments add-on-module change assigned feature clear port copy
feature edit assignments make assignments to another port administration administration menu
directory number distributed hunt group DNIS download data edit data...

Page 172 PC DIU/DIU modem pool to Strata DK modem remote modem to external
modem/TTY port remote modem to modem pool remote modem to Strata DK IMDU (or external
modem) , 15, Strata DK telephone system conventions keyboard customer address contact
name , 130–133, 135, dialer setup...

Page 173 screen conventions security software release system requirements using
DKBackup about backup/restore check system install program software release DNIS address
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reference numbers administration network table assignments number/name/ringing/VM-ID
assignments tenant lock assignments DNIS/DID ringing DNIS/DID/ANI line assignments
documentation viii conventions how to use this manual related , 41, download data...

Page 174 , 32, system modem connection to Strata DK IMDU...

Page 175 print customer program port/station information printer selection screen printer
type selection select printer processor upgrade upgrade RCTU processor program , 76, 108,
112, 114, , 76, 106, 108, 112, *42-1 *42-2 , 101, , 76, 105, 109, 112, 114, 128, 150, , 76, 106,
112, 114, 10-1 10-2...

Page 176 , 12, run for first time set/change LCD messages , 48, 68, speed dial numbers
Strata DK connection system/station administration telephone flexible buttons assignments
change feature transfer DK program data screen , 105, 108, 129, 132, 141, TTY port upgrade...

Page 178 Toshiba America Information Systems, Inc. Telecommunication Systems Division
9740 Irvine Boulevard, Irvine, CA 92618 Item Number: 4 0 1 6 1 5 8 Part Number: D K A - U G -
A D B K P - V C...

This manual is also suitable for:
Strata dk backup
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